Salary Planner Instructions

Step 1 - Log into Faculty/Staff Portal and select Lynx Self Service

Step 2 - Select Employee tah

w WEBER STATE
UNIVERSITY

Personal Information Alumni and Friends Student and Financial Aid Faculty Service:

Search | ] RETURN'

210k Finance

Benefits and Deductions
Update or view your retiremient plans, Health insurance information, Flex spending accounts, miscellansous deductions; Change your

enrollment.

Pay Information

Wiew your Direct Deposit breakdown: View your Earnings and Deductions History: View your Pay Stubs.
Tax Forms

Change W-4 information; View your W-2 Form or T4 Form.

Current and Past Jobs

Time Off Current Balances
Salary p|ag-|;-le.-% Step 3 — Select Salary Planner
E.engﬁt Statement

iR T A

Salary Planner

Copy Scenario ] ]
Edit 5cena--io< Step 4 - Select Edit Scenario
Organization Lock

Query Multiple Extracts

Edit Scenario

&R Choose Extract ID and Scenario, then select filter criteria.

Scenario Selection Step 5 -

Extract ID: | Frosseaup v 4= Select the ID for the current budget year
Scenario: [workING v === Select WORKING for Scenario
Filter Criteria
By Position Attributes: (e
By Employee Name: (O

< Step 6 - Click on Select

Select By Position Attributes




Position Filters

FY085PBUD, WORKING

Organizations:

Include Subordinate Organizations:

Employee Class:

Bargaining Unit:

Faculty Rank:

Include Pooled Positions:
Include Vacant Positions:

Number of Records per Page:

Step 7 -

Select the Department/Level (use the
3-digit organization to work with
entire organization at once)

|900 - Main College Organization Number A |
| 010 - Main Department Organization Number L i

Step 8 — Select
Employee Class
(Ctrl + Left Mouse

e

CF - Classified Full Time
CP - Classified Part Time %

MNaone

Ok to leave dl than one class)

Click to select more

other settings at
the defaults as
listed on this
example

i§

List by Employee ] [

Summary Totals ] [

List by Position ]

Step 9 — Click on List by Employee

List By Employee

Mass Change
Roumding:

Rasson Parcamt Amant

Hons % Step 10 — Make sure Rounding is set to None
Howrky ar Salsry: ;:l_l'h-_"'

General Increase |
Ment Incraase
Equity Incragass

Other [ncreasa

Mass apply

Jump to Battom

Inchede in Changa Totals /

vas Use this section to apply a raise to
¥es all employees that you selected
i (either percent or amount for each

Yesg <

of one or more categories listed).
You can later modify this on an

employee by employee basis.

20211 Admissions Office, Uniecked -
Employaa Totals Dapartmant Totals

In and Position, AppointmentSalary Base Proposed  Base Chamge  Change Amoumt Proposed Extract Excludd
Hame Suffis  Fercent Appointment Appointment Salary Percent Salary Status from

and Titla Parcant Parcant Totals
WOODaTLaR 99080 -

- E— —| Step 11 - Click on the name of the first employee on the list

1]

100,00 18, 194,00 100,00 100,00 18,164.00 a0 a0 18, 164, 00 Ny

SOOI 7061 C997a0 -
L an




Employee Detail 3

Apply increase
amounts on
Job Detail
screen

General Increasi ]

Merit Increass |_

Equit,-IncreaSE[ 7
g
OtherIncreas “ \:-';s

7 royee \ Step 12 — Click on Job Detail link
Name and IC: i #00007 169
Home Organization:
Extracted Jobs
Position Organization Base Propused  Base Genersl  Genersl Increase Merit Merit Incresse  Proposed Salary Links lude
suffix &ppnintmerttﬁppﬁi"tm"t 55|a|"l' Increase  Amount Increase  Amount rom
and Title Percent Percent Percent Percent Totals
CH5350 1000 100,00 15.087.0] | 00| .od] .od][ 19,087.0j30b Datail O
oo T Distribution
Secretaris Comments
II Sosition
Dietail
.0C 19,087.00
Job Detail
Employes 13 7
Name and 10! Person's Name W09090900 Employee Name and “Home
: Org N d Numb H H
S Dmmeonifon, (10 Nafe sl e Organization (Department) show here.
Mass E'halj::-ge -
Rounding: | . .
L | Step 13 — Make sure Rounding is set to None
Rzason Farcent Amount Include in Change Totals

SN 3.50]_ss2.0s0009]

| am i\- =
e — |\ ey
I Fill in and/or change raise amounts

(either percent or amount for each
Step 15 - Click on Apply of one or more categories listed)

Jther Inoresse

# - indicatas =

Job Detail for

Modci Proposed Baze Curm=nt

Effecttve Date! Jul 01, 2007 Jul 01, 2006 Jul 01, 2006

Titie: I Ee:-e:a.-;-_l..l'i Smcratary [ Smcretary II

Hourty Ratz: ¥ [ 5.257255 | r | 9.17s035| 9.175089

annualsalary: ¥ [ 13,755.05 | . 19,087.0q) 19.087.00

Total Change Percent: T el summary will show here
Total Change Amount ! [ ssa.05 |

Appointment Percent: ¥ [ wom [ 190m o000

FTE: ¥ 1 31 1

Hours per Day: ¥ E.DD B.DD

Hours per Pay: ¥ BG6.67 B5.67

Ealary Group: 2007 2007

Tabie: ¥ .

TERET Even though this program allows you to
Step: ¥

change FTE, grade, etc., you must also
submit a PAR. Please note that the title
listed on this screen is not the person’s

Budget Factor: ¥

Estimated Fiscal Year Budgat: *

Exclude from Totals:

Base Job official title; instead it is the payroll
o piei et category assigned to the person. If itis
e _ incorrect, let the Payroll Office know.

Salary Type; Salary




Job Detail continued

Annual Salary: ¥
Total Change Percent:

Total Change Amount:
Appointment Percent: K
FTE: &

Hours per Day: ®
Hours per Pay: x

Salary Group:
Table: ¥

Grade: ¥
Step: X
Budget Factor: #

Estimated Fiscal Year Budget:

Exclude from Totals:

Base Job

Begin Date: Cct 14

End Date:

Job Status: Active
Salary Type: Salary

Ranlz
Tenure Status:
EPAF Transaction #:

*

, 2003

[Sa'.'e] [ Reaet] [ Pravious ] [Next]

Step 17 - Click on Save

Step 18 — Click on Next

! 20213.85| ) 19,430._9_2_i 19,430.92
I 4.03]
| 7=z
| s.00 8.00 5.00
e g6.57  86.57
il 2007 2007
cL_ ¥ cL cL
|__1_:_\_’_: 14 14
|?"_ 0 o
[ 100.00]
[ 20213.85]
L]
Step 16 -

Select Distribution to change how an
employee’s salary is distributed across
different indexes or accounts. (see next
page) You can also add comments for
Budget, HR or Payroll. (see page 6)

Distribution | Default Hours | Position Detail | Comments



Distributicn | Default Hours | Positicn Detzil | Comments

Job Labor Distribution

&R sclect the percent link to change the Proeposed Job Labor Distribution, Select Add & new record to add distribution records.

Distribution

Mame and ID: ai 1T —
Paosition-Suffixand Title: C%%653-00 Clerk

EPAF Transaction #:

Current
COA Index  Fund Organization Account Program ActivityLocation Project Type Cost Type Percent Amount
W 214315120100 20200 61841 510 100.00 13,646.00
Total 100.00 13,646.00
Proposed
COA Index Fund Organization Aecsynt Program ActivityLocation Project Type Cost Type Percent Amount - -
W 214315 120100 20200 @ 510 100.00 12,645.00 | Use this section to

Total 100.00 13,646.00 Change distribution

Add a newrecord

Proposed Position Distribution
COA Index Fund Organization Account Program AdtivityLocation Project Type Cost Type Percent Amount

W 120100 20200 61841 510 100.00 13,646.00
Total 100.00 13,646.00

If you don’t wish to make changes,
just click on the Job Detail link at the
bottom to return to previous screen

c)
con: [T pefaukiomindex ]| g) Before you add a new record
D)
55-159-39—5 (additional FOAP), first note the
-Funs. |1Z0100 - -
— account the person is paid from.

o b) To add a new FOAP, input the Index.
(Brogam ] [e0 | c) Click on Default from Index button.
:— d) Input the account you noted as
_ | mstru_cted above. _

] e) Type in the appropriate percent or
Percent: 'ﬁ@) amount to pay from this new FOAP.

Amount [ 6823.01 f) Click on Save button.
I mportant!
Correct the

Percent amounts
so they total 100.

. Proposed Job Budget Distribution percent does not total 100,

Proposed

COA Index Fund Organization Account Program ActivityLocation Project Type Cost Type Percent Amount

W 214315 120100 20200 61841 510 100.00 13,646.00
W 215030 120100 20000 61841 610 30.00 6,823.00

Total 150.00 20,469.00

This button
not necessary

ion to Job ] [ Copy Job Distribution to Position ]

Employees Detail | 1gb Detsil

When done editing distribution and verifying that the
total percent = 100, click on the button Copy Job
Distribution to Position and then click on Job Detail.




Cistribution | Default Hours | Positicn Detail | Comments

Job Comments

Name and ID: = ey (5

Position-Suffix and Title: C99960-00 Secretary 11

Last Updated by: Betty J Kusnierz

Last Updated on: Feb 27, 2007

Comments: [This person changed from .5 FTE to .75 FTE. PAR processed with effective date
of 5/1/07.

a) Type in appropriate comments.
b) Click on the Save button.
c) Click on Job Detail.

Employee Detail | Job Detail

Job Detail continued

Step 17 -
Refer to Job Detail instructions on pages 3 through 6 to input increase amounts
and other changes for each employee in your selection.

When you are on the last employee, you will no longer have a Next button.

After you’re done with the last employee in your selection, select the
List by Employee link at the bottom of the screen.

Distribution | Default Hours | Position Detail | Comments
List By Employee | List By Position | Employee Detail | Position Filter | Employee Filter | Summary Totals

1



List By Employee

@) Enter a Mass Change or modify an employee, then select Save. Rounding applies to mass change as well as individual employse chan

At this point you will

Hourly or SaMee:  |Both | .
. . have already input your
Reason Pingent Amgahit . . .
G = Increases, so ignore this
eneral Increass| X
i X section.
Merit Increase
Equity Increase |
Other Incre Jes

Jump to Bottom

20240 Registrar's Office, Unlocked

Employeea Totals Department Totals

ID and Position, Appointment Salary Base Proposed Base Change  Change Amount Proposed Extract Excluded
Name Suffix Percent Appointment Appointment Salary Percent Salary Status from

and Title Percent Percent Totals
W 0RE29:1C99591 - 100.0C16,147.13 100.00 100.00 16,147.1% 3.24 S5Z22.94 16,670.07 Mo

00 Clerk

4299570 - 100.0C15,000.00 100.00 100.00 15,000.00 3.01 431.00 15,451.00 Mo

n Clark

Use the List by Employee screen to check and review the overall change
amount and proposed salary for each employee on the list.

Please note that only 25 records show at once, so click on the

button
near the bottom of the page, if there is one, for the next 25 employees.

Step 18: When done with this set of employees, at the bottom of the screen
click on List by Position.
List By Position | Summary Totals

Employee Filter | Position Filter




Step 19: The List by Position screen will show your open positions and allow you to
change the amount budgeted in each. First, at the bottom of the screen click on:

[ Copy Estimated Budget to Budget ]

to copy the Estimated Budget to the Proposed Budget (which will then fill in the
Change Percent and Change Amount). Your open positions will then be easily
identified because the Proposed Budget will be 0. For each of your open positions
modify the Change Amount to adjust the Proposed Budget accordingly.

List By Position

d

B Eriar o Mass Change and sslect Mas\Aaply. or medify an individusl pasitisn and select Save. Rounding spplies to Mass Changes and

Individual position dhanges

Mass Chaimga
Rounding: n
,,_,,_,: o & You can check the Exclude from Totals
box on your open positions so the change
Amaount - R
amount(s) are not included in the change
BT | amount totals at the bottom of the screen.

Jumg Eo Baktom
20240 - Registrar's 0ffice, Unlecked

Pegition and Title Bage Propossd Basa Changs Yeresnt  Changs A t  Propossd B iming Ectimabed Links Extract Excluds
FTE FTE Budget Sudget umit Fisral Statys from
Yaur Tokals
Budget
C55523 sl 3,427,54 S—— 5427, 54015t bution ]
Clari e Tt Commants
Employes
Coa524 5[5 2,097.00 23110 &, 087,000 st bution
Clars Cemrrnsnts
Emiployes
C53331 S0 3,106.2% w757 [ O0Dimtribution
Clark e a — Comemants
Employes
C28359 B= 11 15,500:20 4.00|| 2hdat L3, 310200 =t bution
Clerk iE Commants
Employes
CIEITD 73 75 15.000,00 = 20| 0,00 . 12451000 imtributicn

Cleri - Comnents

As you could do with individual employees, you can also edit the
distribution between different FOAPs and also add comments for
each position. Important: Before you select either, be sure to click
on the Save button at the bottom of the screen to save any Change
Amounts you have added.

If you select distribution, you change it the same way as instructed
on page 5; however, after making your changes and verifying that
the total percent = 100, click on the Update Budget button and then
on the List by Position_link.

\ /
[ CopvPWc‘ntojohs m Update Budget ]
q J

~—
FPaosition Detail
List By Employee T List By Position | Summary Tetals

This
button not
necessary




List By Position

Step 20: After verifying all positions (and budgeting open positions appropriately),
click on Save.

[ Copy Estimated Budget to Budget ]
[ Download Position Data ] [ Download Position and Distribution ]

Feturn to Top

List By Employee | Summary Totals

Employee Filter | Position Filter

To continue with another set of employees, click on Position Filter (and return to Step 7
of these instructions on page 2).

Final Step 1 - Checking for Updates:

As PARs are processed during the salary input “window,” the data in salary planner
will be updated. Before the salary input window closes, complete the following steps:

1) Under Position Filter select the highest org level listed (3-digit org).
2) At the bottom of the Position Filter Screen, click on List by Employee.
3) On the employee list look for any employees where the Extract Status column

says “New” or “Changed.”

cEmployee 10Tals Uvepartment 10TaIs

ID and Position, Appointment Salary Base Proposed Base Change  Change Amount Proposed Extract Excluded
Name Suffix Percent Appointment Appointment Salary Percent Salary Status from
and Title Percent Percent Totals
OEE25 199591 - 100.0016,147.13 100.00 i00.00 16,147.13 3.24 522.94 16,670.07 No
a0 Clerk
599570 - 100.0C15,000.00 100.00 100.00 15,000.00 3.01 451.00 15,451.00 No

4) For those employees that show an Extract Status of “New” or “Changed” repeat
steps 11 through 17 on pages 2-6 to check/update change amounts and proposed

salary.



Final Step 2 - Listing All Positions:

a)

g)

h)

Go to the Position Filter screen and uncheck Include VVacant Positions

Include Vacant Positions: [

Select the highest org level listed (3-digit College org)

At the bottom of the Position Filter screen, click on List by Position

At the bottom of the List by Position screen click on

[ Copy Estimated Budget to Budget ] and then click on

Return to the Position Filter (click on link at bottom of screen)

Re-check Include Vacant Positions

Include Vacant Positions:

Select the highest org level listed (3-digit College org)

At the bottom of the Position Filter screen, click on List by Position

At the bottom of the List by Position screen, click on Download Position and
Distribtuion

[ Copy Estimated Budget to Budget ]

[ Download Position Data ] [ Download Position and Distribution ]

Feturn to Top
List By Employee | Summary Totals

Employee Filter | Position Filter




10

Note: In order for Download Position and Distribution to work, in Internet Explorer,
Internet Options, Security, you need to have enabled File Download and Automatic
Prompting for File Download. In addition, you need to have pop-ups allowed for
*.weber.edu.

v" When prompted as follows:

Save in:
File Download FXI Y
Do you want to open or save this file? My Recent
Select Save and then Cocuments
Mame: bwpkspos,csy
@ Type: Microsaft Excel Worksheet, 4.46KE SEIeCt DeSktop as the
Fram: selfservice.weber.edu Iocatl on.
Open [ Save ] Y Cancel |
Always ask before opening this tppe of fi My Docunents
" “Ml While files from the Intemet can be useful, some files can patentially -
@ harm pour computer. [F pou do not trugt the zource, do not open or t}j
i save this file. What's the risk? My Computer
by Metwork,

Final Step 3 -
Using Excel to Total Downloaded Position and Distribution Information

1) Open Excel
2) Open bwpkspos file. Please note that you need to “Look in” your Desktop and
change the “Files of type” to be All Files

Open 2 X

Look in: (B} Desktop | &= ~ BE5 @ > - Tools ~
. Marme - Size  Type -~
_:;__ﬁ»j @adjunctsnatinsiainst 24 KB Microsoft Excel Wor. ..
History 2N Aadjunctn 42 KB Microsoft Excel War...
= adnewhire 28 KB adobe Acrobat 7.0 ...

B autohiofor m 59 KB Microsoft Word Doc...
BannerHR Autarnated Faculty ... 4,506 KB Microsoft Word Doc...
1S 5 KB Microsoft Excel Com...

My Documents

2 new 29 KB Microsoft Excel Wor...
= pcardlog 20 KB  adobe Acrobat 7.0 ...
L B pcardstate ments 156 KB Rich Text Format
Desktop 2 salcheck 561 KB Microsoft Excel Wor. ..
" 2 saldownload-02-20-07 517 KB Microsoft Excel Wor... q
| % i 37 ter minatedad juncts 22 KB Microsoft Excel Wor...
2 = wendrRegWa 101 KB Adobe Acrobat 7.0 ...
Eavites Bl S5 KB Microsoft Excel Com... ¥
< | >

File pame:

=1 open |~
;j Cancel

[y Metwork
Flaces

Files of tvpe:  [all Files




11
3) Scroll down the Worksheet to the section labeled “NBREPLD: Extracted Position
Labor Distribution Salary Planner Table.”
4) Use your mouse to click and drag to select the contents of this section of the
spreadsheet starting with and including the row of column labels (Position,
Organization, etc.).

5) Under the Data menu select Sort and then specify “Sort by” as Fund Code and
“Then by as Orgn Code. Click on OK.

=

=

40 MEREPLD: Extracted Posiion Labar Disinbudion Salary Planrer Table Sort ﬁlﬁl

41 Posilion  Crganizati Percem Pr Recond Sii Pr Coas CodeAcci Code Furd Code Ongn CodeAccl Code P N Cnde AL

42 TR a0 100 N ETVT TN X200 BB | Sotby

Rl [z el 40 100 M A W G0 A0 aa BB | o] e

A || S0 100 100 25 SO0 X2a - BB P it

35 |crees 240 oc 0w 5N T 000 FB | ety

4B |coesEn e 100 H 125102 W ol L R - g e

AT |ceesTD ] 100 M 15000 W 4310 EN00 X4 BRI e

48 |cooeEs 40 100 H N7 AW D A4l BB | 2

49 |coeEm 24D 100 H 14T 13 W 10 XEM B =

E)[GeeRis  AedD IO H LI W 10 ARA BB =] | S

&1 |ceerzn 40 100 N 18135 W a0 1IN0 MR BIEE] il

B2 |cerEr 2040 100 H 21000 W J0E0 1IN0 Aa EIEIE | Mwkthes

5 |CEOEDE 20eM0 LR PIHI AW 1EM00 A4l BIEM3  teadwesen 7 o header g

£4 |eoeeED S0 100 M 18500 W N0 X240 BB

5 | CROEEE: 2240 10 H 1EEM4E.,09 W 1A 2EM EIEE ik |I| Cacel

55 |ceeeen e i} 100 H 191381 W TN AW e

=T |Eoocea 20 100 M 0w 1200 30 B 10

E5 |Peeds 40 100 H BE000 W 43D AADD A4 BAEES 510

8 |Posesr et 6 230 W 240 T XA BIEES 510

O |PEeEsT arelil EIRH PELLIRS 2500 N0 A0 BiEES 510

B |PesEsE ] 100 M FEEIOT W BT U v R T 10

B2 |PecEER 240 100 N JETBED W 1AM 2R BITE 10

& |FEer 20z 100 H SEISTE W [0 . O A = sl

Fd

6) Do not click elsewhere in the spreadsheet — leave the text selected.

7) Under the Tools menu select Options and on the View tab make sure that
“Outline symbols’ is checked. Click on OK.

Options

Window options
| Page breaks
[ Formulas
v cridines

|v Row & column headers
v Outline symbols
W Zero values

aridlines colar;

Automatic

&

Color ] Inkernatiogal ] Save ] Error Checking ] Spelling ] Security ]
______________ "J' IEW] Calculation Edit l General Transition Cuskom Lists Chart 1
Show

| startup Task Pane Formula bar [+ Status bar ¥ Windows in Taskbar
Commenks

" None * Comment indicatar anlky " Comrment & indicator
Ohbjects

{* Show all " Show placeholders " Hide all

W Horizorkal scroll bar
¥ Yertical scroll bar
W Sheet tabs

]

Cancel




e 1 e —

8)

12

Under the Data menu select Subtotals. Complete the Subtotal box as pictured
below. Click on OK.

“Add subtotal to:”

27(C99990 | 1-JukO7|  20231[CF 5 1 1 100 100N M [
P '

2]

30 — — &k each change in:

3 WBREPLD: Extracted Position Labor Digtribution Salary Planner Table. |Fund code ﬂ
| 32 |Paosition  Organizati Percent PrRecord St: Budget PreCoas CodeAcci Code H

| 33 |co9s15 20231 100¢C 22060.03 W Use function:

| 34 |c99674 20231 100 © 20974 26 W [5um P
| 36 |£99685 20231 100 © 2002009 W 214205

|36 [c99714 20231 100 © 24924 05 W RSl iy

57 |cog72s 20231 100 ¢ 32381.64 W e aposed A
| 38 |Cc99853 20231 100 © 21380 44 W < =
| 39 |co9s77 20231 100 © |37 08

| 40 |£99990 20231 100 © 19874 B2 W =

41 |co9R2 20231 100 ¢ 2454361 W ¥ (Replacsc itent sbeotals

47 |c99713 20231 100 ¢ 20376 64 W R | Erom breokbetueen gronps

43 IV Surmmary belaw data

jg Make sure Budget Remaove Al ‘ oK I Cancel
45| .

7 Proposed is the only

2 item checked under

Code Locn CodeProj ¢

9) Again select Subtotals under the Data menu and this time complete the subtotal
box as pictured below. Click on OK.

Subtotal

AE sach Chengs n:

21X

[ o
ke funcbore

[5um

i subbobsl to:

I Fiapleor pimert aikots]

| Percert Fropassd
™ Fincord Sketus

[ E gt Py oposed bl |

Eap= hieak betmesn groups

e

Canice|

sl

=

1}

31 MEREPLD: Exiracied Postion Labor Distnbulion Salary Planner Table

_ﬂ__ ﬁﬂ?ﬂlﬂﬂ Eaﬂﬂlla‘"l ﬂarcar‘ﬂ ﬂr ﬂatn a § sEqua‘t ﬁl’( &59 EDdEEEI Eﬂaﬂ Funa EDEE
33 |03ee15 2023 100 o 2206003 W 101
34 |CHETS 23 100 20597476 W 120100
35 |CI0eES Ar2ai 100 A00A005 W 2105 12000
JiE (== 2133 100.C 24590406 W 120100
37 |CanyE LU 100 ¢ 2233194 W 1201
34 [camasm 2231 100 & 21380 44 W 120100
33 |CasETF e | 00 24E37 06 W 121100
A |£95550 FLIPE] 1006 19674.62 W 1207
41 186452 4 120400 Tot
42 |Cobe a3 100 ¢ 2AEA4ZET W
43 [CAEF13 2023 100 o FIIFE RS W

Bl AT 45

A5 21720

45

47

43 . .

a Note that this time

you uncheck
Replace current
subtotals

CodeProgy Code Chyp e
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10) Click on the Outline Number 3 if you have 4 outline numbers

/ E&G

1234 A B © D E F G H | L
95 Totals
95 [WBREFLD: Esxtracted FPosition Labor Distributi anner Table.
97 |Position | OrganizatiiPercent PrRecorgMfBudget PriCoas Code Acci Code Fund Code Orgn Code Code Prog Code Actv Code
[ [+ 100 33069.44 20000 Total
+ 104 a5092.74 20200 Total
+ 105 3942626 20201 Total
# 122 452068 20211 Total
+ 135 395922 5 20221 Total
#1137 18337.09 20222 Total
+ 158 F40147 .2 20231 Total
+ 180 474801 4 20240 Total
+ 182 1 51500 65000 Total
= 183 2190365 120100 Total
[ - 184 |C99692 20231 100 C 22040 1 61973 510
185|CO9713 20231 100 C 22376 64 W memraT 220401 20231 F1973 a10
186 | POORGT 20201 10C 4380.7 W 22040 2023 F1750 a10
187 |P9g97E1 20231 051 c 22087 W 22040 2023 F1535 a10
g 188 |P99973 20231 9 3927 12 W 220401 2023 61535 a10
= 189 55549.14 220401 Total
- 190 5554914 20231 Total
= 191 2245814 Grand Total
192
or on Outline Number 2 if your have 3 outline numbers
1)2]3 A B G O E F G H J 58

40
41 |NBREPLD: Extracted Position Labor Distribution Salary FPlanner Table.
42 |Position  OrganizatitPercent PrRecord Sti Budget PriCoas Code Acci Code Fund Code Orgn Code Acct Code Prog Code 2

+ | B2 B17418.4 120100 Total
g 63 617418.4 20231 Total
+ | BB 51168 44 220401 Total
g B9 51168.44 20231 Total
= 70 GRESERE B Grand Total
71
72
73

This will show you a total for each E&G “Org” as well as an E&G total.

This will also show you totals for each of your non-E&G “Funds”.



Final Step 4 -

Extracting Salary Information by Employee into Excel

14

When all changes have been input, you canextract the salary informationfor all employeesinto

Excdl.
1. Follow Steps 1 through 9 on pages1 & 2- under Position Filter
select the highest org level listed (3-digit College org).
2.

[ Save ] [ Reset ]

At the bottom of the List by Employee screen, click on
Download Job and Distribution

[ Download Job Data

I

Download Job and Distribution

3. Click on Save and then select Desktop as the location m

File Download

Do you want to open or saveRthis file?

&)

Mame: bwpksjob.csv
Tupe: Microsoft Excel WoNgsheet, 5.33KE
From:  selfservice, weber, ed

Save i

Documents

Desktop

J [

Open

Cancel |

Always ask before opening this tppe of file

@

save this file. What's the risk?

“while filez from the Intermet can be useful, some files can potentially
harm pour computer. If pou da nat trust the source, do not open or

<y

by Documents

ty Computer

4. Open Excel

—

by Metwark,

5. Open bwpksjob file. Please note that you need to “Look in” your Desktop and
change the “Files of type” to be All Files

Open 21X
Lok | Dasibtop -] 4= & X 0 - Tader
= Harre Size | Type ~
] ®jedunc 42 KB Microsoft Excel ...
Hetiry ¥ )adints 267 KB Microsoft Excel Wor. ..
= adnewhire 2B KB Achobs Acrobst 200,
oy suhiofirm SO KB Microsoft wand Do,
T | EariarHR. Ammsted Facufty .. 4,506 kB Micrasoft Wiard Doc...
e | btk 412 KB FEG Image
l B kB Microsoft Excel Com.., :
[0 T} fLournl Coee,

Tupe: Miorosoft Evoel Comma Separated Yalues File
Cate Modified: 3/2,/2007 B:50 &M

= peardlog Szm: 5.3 KB
Bpcardstaements 32 FE Fidh Test Format
o salched: 551 KB Micrasoft Excal nior,,. |
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The dataare in four parts:

Pat 1. The NBREJOB section lists each employee with their current
annual salary (column M) and their new annual salary (column N)

B C D E
rio: |WWORKIM !
iz atit 999 Fictitious College
E SuY
yee All
ning All
v Rz All
Pa Y
b

15 |NBREJOB:
5 ID

tracted Job Detail Salary Planner Table.
ft MameFirst Narne Middle Mar Position | Suffix Effective D Effective D Parsonnel OrganizatiPosition E Employes Annual Sa Annual Sa Appaintme Ap

17 TTreaes B2 Jones Laura Ann Po9752 0 1-Juk06  1-Jul0? | 1-Jul07 20150 PF PF 35375.51 3B636.78 100
18 WDDDD1?4 Smith Andrea B 99563 016-Dec-06  1-Jul07 | 1-Jul-07 20120 CF CF 114400 11933.2 100
19 0108318 Brown Parmela 99528 0 13-Mow-06  1-Jul07 | 1-Jul-07 20115 CP CF 15600 16268 100
20 WWD000205 White Robert H P229665 0 1-Juk06  1-Jul07 | 1-JulO07 20150 PF PF B0486.22 F2500.81 100
21 W0000126 Johnson  Rebecca Fo9576 0 1-Juk06  1-Jul0? | 1-Jul07 20125 FF FF 728568 752425 100

NamE First Marnebiddle MNar F'osmun Suffix Effective D Job Chang Change Pe Change Armount

Laura Ann P99752 0 1-Jul-06 COLA 3 1061.27
Laura Ann P99752 0 1-Jul-06 MERIT 0.57 200
Andrea B 99563 016-Dec-06 COLA 3 343.2
Andrea B 99563 0 16-Dec-06 MERIT 176 200
Parnela 99528 0 13-Mov-06 COLA, 3 465
Pamela COSRR N1 A3-Maw-NR RFRIT 12R wnn

The NBRSALC section lists each employee with each change amount allocated to
that employee. Note: COLA isthe Job Change code used for general increase
(satisfactory performance).

Part 3.  You can delete the NBRERRN section - it only shows the calculated hours per pay
period (40 hrs per week times 52 weeks per year divided by 24 pay periods = 86.67
for a full-time person, 43.34 for a half-time person, 65 for a 75% person, etc.).

St Mame First Mame Middle NarPosition | Suffix Effective Da Effective [ Earn Code Organizatii Shift Record StiHours Hours Prog Cancel Da S
WOOOI1 74 Smith Andrea B 99563 0 16-Dec-06  1-Jul-07 5 20120 1N 43.34 43.34
43 'W0108318 Brown Parnela 99528 0 13-Mow06  1-Jul-o7 5 20115 1M 65 =i}

acted Job Labor Distribution Salary Planner Table.
agh Marne First Name Middle MNarPosition | Suffix Effective Da OrganizatiiPercent PrRecord St Coas Code Acci Code Fund Code Orgn Code Acct Code P
o lones Laura Ann Po9752

o 1-Juk0? 20150 86 M WY 215050 120100 20150 51510

(65 Jones Laura Ann Po9752 o 1-Juk0? 20150 140 WY 228006 130200 20150 51510
4 Emith Andrea B Co9563 o 1-Juk0? 20120 oc W 215030, 120100 20000 615967
4 Smith Andrea B 89563 o 1-Julk0? 20120 100N W 213525 120100 20120 615957
74 Smith Andrea B 90563 o 1-Julk0? 20120 a0 c WY 215030, 120100 20000 B1957
13 Brown Pamela 99528 0 1-Julkd? 20115 BE.E7 N WY 2040320 120100 20115 61957
15 Brown Pamela Co9528 o 1-Juk0? 20115 33.33 N Wy 213609 120100 20160 51957
05 White Robert H PS9869 o 1-Juk0? 20150 85.79 N Wy 215050 120100 20150 51600
05 White Robert H PS9869 o 1-Juk0? 20150 14210 WY 228006 130200 20150 51600

( A\

4. TheNBREJLD section shows how the person will be split across different FOAPs.

The example shows how the data comes into Excel. From here you can resize columns, copy
each section into a new spreadsheet, eliminate unnecessary columns, sort the data, etc.



